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Introduction 

 

The purpose of graduate study is to provide academic opportunities to extend the 

boundaries of knowledge and experience. These opportunities enable qualified 

individuals to obtain a comprehensive and thorough understanding of a more specific 

body of knowledge. A thesis or research paper constitutes a tangible measure of this 

academic achievement. 

 

The candidate for a master’s degree is expected to have a strong general knowledge of 

the field and competence in the research and applied skills recognized in that field. The 

candidate and the Advisory Committee share with the University the responsibility for 

protecting and improving this quality. The value of any research or scholarly activity is a 

direct result of the skill with which it is communicated to fellow specialists and other 

educated people. Bemidji State University subscribes to the highest ethical standards in 

the conduct of all scholarly endeavors. In this regard, all sources contained in the 

investigation shall be given proper credit.  

 

The candidate, as the principal investigator and author, is expected to display initiative in 

planning a satisfactory program of investigation, in completing the investigation, and in 

writing a thesis or research paper in accordance with the requirements of both the general 

graduate guidelines and the department/program style requirements. Theses and research 

papers differ primarily in representing different levels of investigation, specialization, and 

presentation. Although there are important differences in the level of investigation 

represented by the master’s thesis and research paper, both are similar end products of 

investigation. Both must conform to certain fundamental rules of literary and scholarly 

presentation.  

 

A research project involves the collection, evaluation, and effective presentation of 

information pertaining to a clearly defined problem of a limited scope. The degree 

candidate is expected to perform in a manner that demonstrates respect for grammatical 

principles and to reflect competent literary style. The mode of scholarly presentation will 

vary according to the different fields of knowledge. The research process requires close 

contact between the degree candidate and the entire advisory committee. 
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Thesis, Research Paper, and Graduation Expenses 
 

All thesis and research paper candidates are required to register via arranged course work 

for credit at which time the initial investigation commences. The precise number of 

thesis/research paper credits required may vary:   

 

 The thesis credit requirement may not exceed six (6) semester hours.   

 The research paper may not exceed two (2) semester hours.   

 

The candidate is expected to meet with his/her advisor for the purpose of presenting an 

initial topic proposal to the Advisory Committee. This meeting should occur prior to 

initiating the investigative process. The candidate should also seek input and approval 

from all committee members on the research topic.  Once the topic is approved by the 

committee, the student should submit a proposal and Form 3 – Graduate Research 

Paper/Thesis Proposal Approval Form to the School of Graduate Studies.  

 

 

Expenses 

 

The actual expenses incurred in the preparation and duplication of the thesis/research 

paper will vary. The following is a list of expenses that may be incurred: 

 

1. A word processing service fee (optional). 

2. Twenty-pound, 25 to 100 percent rag or cotton bond paper (required for the final 

thesis copy only). 

3. Photocopying of the four draft copies to be provided to the three Oral 

Examination Committee members and the Graduate Faculty Representative.  

4. Submission of final paper: 

a. Thesis: Bindings for the two final copies of the thesis (one twenty-pound 

copy and one photocopy for the library and any additional for personal use) 

are to be submitted to the School of Graduate Studies once appropriate 

signatures have been secured. 

b. Research Paper: A single research paper copy (with original signatures of 

committee members and Graduate Faculty Representative) for the department 

must be submitted to the School of Graduate Studies. Research papers are not 

provided to the library. 
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Eleven Steps to the Successful Completion of the Thesis or Research Paper 

 

1. Once approval has been given for Admission to Candidacy, the candidate selects 

a research topic or problem with the approval of the advisor. 

 

2. The candidate determines the members of the master’s committee in consultation 

with the advisor.  

 

3. The candidate prepares a proposal on the research topic for presentation to the 

committee members. Once all committee members approve the topic, Form 3 – 

Proposal Approval Form, is signed by committee members and submitted to the 

School of Graduate Studies. 

 

4. The candidate conducts the necessary investigation with the guidance of the 

advisor and in conjunction with the committee members. If the investigation will 

involve human subjects, approval must be secured PRIOR to implementation of 

data collection. Please visit the School of Graduate Studies website for more 

information. 

 

5. The initial draft is provided to the advisor for review. Once the advisor has 

reviewed the draft, a copy is provided to all members of the master’s committee. 

 

6. The candidate will submit Form 4 – Application for Graduation. Note: 

Candidates should register for the thesis/research paper credits with the 

advisor at this time, during the semester or summer session in which the oral 

defense is scheduled. 
 

7. When the members of the student’s graduate committee have read and provided 

feedback to the student, the candidate will secure signatures on Form 5, Pre-

Defense Signature, and submit the form to the School of Graduate Studies. Only 

after the student has submitted Form 5 will the School of Graduate Studies assign 

a Graduate Faculty Representative to the student’s graduate committee. 

 

8. An electronic AND hard copy of the approved draft is provided to the School of 

Graduate Studies at least three weeks prior to the date of the oral examination. 

The electronic copy will be reviewed for formatting and the hard copy will be 

forwarded to the appointed Graduate Faculty Representative.  

 

9. The candidate defends the thesis/research paper at the oral examination. The 

committee may request modifications or changes to the draft, based on the oral 

defense.  

 

10. All modifications or changes to the thesis/research paper must be completed to the 

satisfaction of the advisor and/or committee.   
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11. Provide the approved manuscript(s) to the advisor and committee for signatures. 

Then submit the manuscript(s) to the School of Graduate Studies. 

 

a. The thesis candidate must provide two (2) approved manuscripts for 

signatures. One thesis copy must be on twenty-pound, 25 to 100 percent rag or 

cotton bond paper. The copies must be two- or three-hole punched and bound 

in a black left-sided, heavy-duty report cover with metal fasteners (provided 

by Graduate Studies). The exact title of the thesis and the full name of the 

author must appear on the front cover. 

 

b. The research paper candidate must provide one (1) approved manuscript for 

signatures. Regular printer paper may be used for the research paper. The 

copy must be two- or three-hole punched and bound in a black left-sided, 

heavy-duty report cover with metal fasteners (provided by Graduate Studies). 

The exact title of the research paper and the full name of the author must 

appear on the front cover. 
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Page Sequence of a Thesis or Research Paper 

 

Every thesis or research paper submitted to the School of Graduate Studies must conform 

in every aspect to the following requirements.  

 Page 

1. Label on front cover ...................................................................................... 17 

2. Blank sheet (fly leaf) - unnumbered  

3. Address page – unnumbered ......................................................................... 18 

4. Title page - small Roman i ............................................................................ 19 

5. Author’s Statement/Approval page - (small Roman ii) ................................ 20 

6. Abstract page - (small Roman iii) ................................................................. 21 

7. Acknowledgments page (optional) - (small Roman iv) ................................ 22 

8. Table of Contents page(s) - (small Roman number) ....... 24(APA), 34 (MLA) 

9. List of Tables page - (small Roman number) ............................................... 28 

10. List of Figures page – (small Roman number) ............................................. 29  

11. Text pages – numbered (Arabic)  

12. References/Works Cited page(s) - numbered (Arabic) .... 37(APA), 42(MLA) 

13. Appendix page(s)* - numbered (Arabic) 

14. Blank sheet (fly leaf) - unnumbered  

 

Note: All page numbers, both Roman and Arabic, are to be placed in the upper right hand 

corner of the page. The placement is 1/2" from the top of the page and aligned with the 

right margin (within the header).  

 

APA: Page numbers are required. A page header (the first two or three words 

of the title) is optional; see p. 230 of the APA Manual 6
th

 Edition.  

 

MLA: Last name of student and page number are required. 

 
 

* The appendix page(s) follow the References or Works Cited pages only if there are no 

references cited in any appendix. If any appendix contains reference citations, the 

References or Works Cited pages follow the appendix pages. 
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General Guidelines 

 

The mechanics: The department/program style manual (APA, MLA, etc.) takes 

precedence over all general guidelines with the exception of the front matter pages. 

Students should use the Handbook for the Preparation of the Thesis or Research Paper in 

order to correctly format their papers/projects and should supplement with other 

specialized handbooks that may come from their departments or are available online. 

 

Abstract – The final required element in the preliminary or front matter (before the 

Table of Contents) is the abstract. The abstract should begin with a clear 

statement of the problem. The purpose of the abstract is to concisely summarize 

the methods of investigation, significant content, system of analysis, findings, and 

conclusions of the study. The abstract statement should not exceed 300 words. 

The abstract is to be written in the same person and tense as the text (See p. 21).  

 

Acknowledgments – Acknowledgments recognize the person(s) to whom the student is 

indebted for encouragement, guidance and special assistance. This page should 

also include recognition of any grants or financial assistance that was received to 

support the research. This page is optional. No part of the thesis/research paper 

that is essential to the understanding of the main body of the text should appear on 

the acknowledgment page (See p. 22). 

 

Appendix Pages – An appendix contains material that is useful for detailed review, but is 

not essential to the study. For example, an appendix is an appropriate section in 

which to place certain kinds of tabular and graphic material. This material is 

available as supporting data even though it may not be specifically utilized in the 

text. However, such material must be referenced in the text.  

 

Each appendix is identified by a letter in a sequence independent of the 

numbering system used for the chapters. However, the pages of an appendix are 

numbered in sequence with those in the text. Each appendix must begin on a 

new page and must be listed in the Table of Contents.  

 

The appendix pages follow the References or Works Cited pages only if there 

are no references cited in any appendix. Consult the required 

department/program style manual (APA, MLA, etc.) for correct formatting.  

 

Author’s Statement/Approval Form – There are two primary purposes for this page. 

The first indicates approval of the thesis/research paper by the student’s advisor 

and the College Dean. The second protects the research from unauthorized use. 

The author approval form should follow the title page.  

 

Back-to-Back Printing Option – Students wishing to utilize back-to-back printing for 

their thesis/research paper may do so by following the guidelines in Appendices D-F.  

Heavier paper (25%, 32 lb. cotton paper for theses) will be required for all back-to-back 

printing. 
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Binding – The approved manuscript(s) with original signatures from the committee 

members and graduate faculty representative must be submitted to the School of 

Graduate Studies appropriately formatted and prepared for binding. For those who 

wish to bind their own work, a black heavy-duty report cover with metal 

fasteners (two- or three-hole punch) is required, and the exact title of the thesis or 

research paper and the full name of the author must appear on the front cover.  

See page 8 for correct page sequencing.  The following indicates the correct 

number of copies that must be submitted to the School of Graduate Studies: 

 Thesis: Two (2) approved manuscripts of the thesis must be submitted (See 

“Paper” for further details). 

 Research Paper: One (1) approved copy of the research paper must be 

submitted. 

 

*Those who wish to have additional copies bound must provide their own 

binders.   

 

Capitalization – All research projects must conform to standard rules in the use of 

capitalization (See the appropriate department/program style manual, i.e., APA, 

MLA, etc.).  

 

Centering/Vertical Centering – When centering is required, all word-processed copies 

should be centered within the margins of the paper, not within the 8 1/2 x 11 inch 

page. The margin spacing will vary depending on the type style selected. This 

also applies to charts, tables, graphs, figures, or other reproductions. Some front 

matter pages require vertical centering. Note: There are templates available on 

the School of Graduate Studies website, which already have the vertical 

centering done for you. 

 

To center text vertically on a page yourself:  

Microsoft
®
 Word 2007 

1. Insert page breaks before and 

after the text to be vertically 

centered  

2. Highlight the text to be vertically 

centered. 

3. On the Page Layout tab, select 

the lower right corner of Page 

Setup 

4. Go to the Layout tab 

5. Under Page, Vertical alignment, 

select Center  

6. Be sure that the “Apply to:” box 

shows “this section”  

7. Click on OK 

Microsoft
®
 Word 2010 

1. Insert page breaks before and 

after the text to be vertically 

centered  

2. Highlight the text to be 

vertically centered. 

3. On the Page Layout tab, 

select the lower right corner 

of Page Setup 

4. Go to the Layout tab 

5. Under Page, Vertical 

alignment, select Center  

6. Be sure that the “Apply to:” 

box shows “selected section”  

7. Click on OK
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Chapter Headings – APA – see APA Manual 6
th

 Edition, pages 62-63; MLA  

 

Copies Required – Four draft copies are required for the examination committee. One 

hard copy AND electronic copy is to be provided to the School of Graduate 

Studies at least three weeks prior to the oral examination. The hard copy will 

be provided to the Graduate Faculty Representative and the electronic copy will 

be reviewed for formatting 

 

Copyright – Typically, theses are not copyrighted. If the student’s thesis will be 

published, it should be copyrighted. A copyright notice should be included in the 

title page.  

 

Duplication – Two methods have been approved for the reproduction of a thesis/research 

paper. The first acceptable method consists of a photocopy of the original.  The 

second method includes two copies produced on a word processor. All copies 

must be neat and clean. Inferior photocopies or those with dirty, smudged, or 

streaked backgrounds will not be approved. Pages of illustrations or graphs that 

cannot be corrected on a word processor may be printed by an approved 

alternative process. It is recommended that candidates consult with the School of 

Graduate Studies for the purpose of reviewing alternative processes.  

 

Erasures and Strikeovers – Erasures and strikeovers are not permitted on the final 

copies. Correction fluid may not be used in the removal of errors.   

 

Figures – All figure captions should conform to the guidelines in the approved style 

manual (APA, MLA, etc.). If figures are involved, a List of Figures page(s) 

should immediately follow the Table of Contents and any List of Tables page(s) 

in the front matter.  

 

Fly Leaf – The fly leaf sheets are not numbered. The purpose of these sheets is to protect 

the title page and back matter. The fly leaf blank sheets should precede the title 

page and follow the last page in the manuscript.  

 

Front Matter – This section consists of all preliminary information (title page, statement 

by author, abstract, etc.) prior to the presentation of the text (see Appendix A). 

 

List of Figures - The entries should be identical to the figure captions in the text and 

conform to the guidelines in the approved style manual. The List of Figures 

page(s) should immediately follow the Table of Contents and any List of Tables 

page(s) in the front matter. 

 

List of Tables – The entries should be identical to the table titles in the text and conform 

to the guidelines in the approved style manual (APA, MLA, etc.). If tables are 

involved, the List of Tables page(s) should immediately follow the Table of 

Contents page(s) in the front matter. 
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Margins – The text margin guidelines are contained in the handbook.  Additional margin 

guidelines may be included in the departmental/program style manual (APA, 

MLA, etc.). Generally, the left margin must be one and one-half inches (1½”) in 

width with the other margins (top, right, bottom) one inch (1”) in width. All 

typing, reproductions, appendices, and footnotes, must be within these margins. 

All page numbers are to be ½ " from top of page, aligned with the right margin. 

The text of the paper must be double spaced, with the exception of lengthy 

quotations (APA/MLA) and the references (APA). Consult with the required 

departmental/program style manual for additional information. You do have the 

option to print back-to-back; please refer to that section for appropriate 

instructions. 

 

Page Numbering Sequence – All front matter pages (title page, abstract, etc.) must be 

numbered with Roman numerals. The title page is counted as the first page, and is 

numbered “i”. All text pages must carry Arabic numbers beginning with “1”. 

Every page must be accounted for in the numbering system with the exception of 

the fly leaf sheets and the address page. *MLA: Last name must appear on all 

numbered pages of the research/thesis paper. 

 

Paper – The paper to be used for research papers and final library approved thesis 

manuscript copies must be 8½ x 11 inches in dimension.  

 Thesis papers must be printed on 20-pound bond, having 25 to 100 percent 

rag or cotton content (the second copy may be a photocopy). Erase, 

correctable, or other erasable bond paper is not acceptable. Continuous feed 

paper cannot be used. The entire paper must be of the same quality, brand, and 

degree of whiteness. Bond paper is water marked. The paper should be 

arranged so the watermark is both right side and top-side up (see Word 

Processing).  

 Research papers may be printed on 20-pound, non-cotton printer paper. 

 Printing back-to-back will require a heavier cotton paper. See  

 

Photocopying – Very specific rules and guidelines govern the circumstances under 

which photocopying may occur. Contact the University Library when using 

copyrighted works in the text. Guidelines are also available in the Copyright 

Office Circular R21, “Reproduction of Copyrighted Works by Educators and 

Librarians.” This publication is available through the United States Copyright 

Office.  

 

Preface – (See “Acknowledgments”) 

 

Questionnaires, Surveys, and Related Materials – The purpose of illustrative material 

is to present information or data in a format more clearly than it can be stated in 

words alone (see “Figures”). All illustrative materials must be presented on an 

8½ x 11 inch page and within the acceptable margins. The candidate is 

encouraged to consult with the department/program style manual (APA, MLA, 

etc.) because of the variability in the nature of illustrations. *Students who plan 



 

13 

Return to top: Table of Contents 

 

to use human subjects in their research must seek approval from the Human 

Subjects Committee prior to collecting the data. Appropriate approval forms 

may be accessed through the School of Graduate Studies’ website. 

 

References or Works Cited – All studies must contain source information. In most 

instances, the source information is called “References” (APA) or “Works Cited” 

(MLA) and consists only of sources cited in the text or appendices. The 

References or Works Cited pages should follow the text, and the pages are 

numbered in sequence with the text. If any appendix contains reference 

citations, the References or Works Cited pages follow the appendix pages. 

Consult the appropriate department/program style manual for the correct form. 

 

Special Mountings with Adhesives – A large photograph or a full page of photographic 

illustrations should be directly on photographic paper 8½ x 11 inches. However, if 

photographs or other materials requiring special mountings are included, the 

paper for mounts should be “Alexis” Lietz Sequbio (#1005), or pliable Bristol 

Board in sheets 8½ x 11 inches. The adhesive may be Kodak Dry Mounting 

Tissue or a polyvinyl plastic adhesive, such as Duratite, Wilhold, or Borden’s. 

*Do not use rubber cement under any circumstances. Double-faced scotch 

tape may be used if special care is exercised so as not to allow the tape to show.  

 

Style Manuals – Each department/program has a required style manual to be used for the 

thesis/research paper. The most recent edition is to be used in all research.  

 

APA –Students must use Publication manual of the American Psychological 

Association, 6
th

 Ed., Washington, D.C.: American Psychological Association. 

 

MLA – Modern Language Association of America. MLA Style Manual and Guide 

to Scholarly Publishing, 3
rd

 Ed. New York, NY: 2008. 

 

 Biology – After consent with their advisors, students will follow the format of 

the Publication Manual of the American Psychological Association or an 

appropriate journal in their area of expertise. *Students must provide a 

complete description and examples for the journal format they wish to 

use to the School of Graduate Studies when they submit their final draft 

for formatting review. 
 

 Business Administration (MBA) - Publication Manual of the American 

Psychological Association (APA) 

 

 Counseling Psychology - Publication Manual of the American Psychological 

Association (APA) 

 

 Education – Publication Manual of the American Psychological Association  
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 English – The thesis or research paper is written using either the APA or 

MLA style manual as determined by the major advisor. 

 

 Environmental Studies – After consent with their advisors, students will 

follow the format of the Publication Manual of the American Psychological 

Association or an appropriate journal in their area of expertise. *Students 

must provide a complete description and examples for the journal format 

they wish to use to the School of Graduate Studies when they submit their 

final draft for formatting review. 
 

 Mathematics – Publication Manual of the American Psychological 

Association (APA)  

 

 Special Education – Publication Manual of the American Psychological 

Association  

 

Table of Contents – The Table of Contents is a complete listing with page numbers of 

all sections of the thesis or research paper. Since most theses and research papers 

do not have an index, it is desirable to have the Table of Contents be a detailed 

listing of all major subdivisions of the text rather than a simple list of chapter 

headings. 

 

 Entries – It is essential that wording in the Table of Contents listing be 

identical to that of the heading in the text in every case. A sample Table of 

Contents is provided on pp. 24 (APA) and 34 (MLA). 

 

 Page Numbers – Align the page numbers flush right with dot leaders.  

o In Microsoft
®
 Word 2007, from the Home tab, go to the Paragraph 

section and select the small arrow in the lower right corner.  Select Tabs in 

the lower left corner of the Paragraph window. Select or type in the tab 

stop position and select Alignment Right and Leader 2 ……. . Click Set 

and Ok. 

o In Microsoft
®
 Word 2010, from the Home tab, go to the Paragraph 

section and select the small arrow in the lower right corner.  Select Tabs in 

the lower left corner of the Paragraph window. Select or type in the tab 

stop position and select Alignment Right and Leader 2 ……. . Click Set 

and Ok. 

 

Tables – All Tables and table titles should conform to the guidelines in the approved 

style manual (APA, MLA, etc.). If tables are involved, the List of Tables page(s) 

should immediately follow the Table of Contents page(s) in the front matter.  The 

table titles should be identical to the entries in the List of Tables. 

 

Word Processing – The final copy must be produced on a letter quality printer.  Students 

are permitted to use Printing Services (Deputy Hall 210) or access the BSU 

Library to print their final drafts. 
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 Text – The text is the main body of the thesis/research paper. Text is 

generally double-spaced, except where otherwise indicated (e.g. block quotes, 

table titles and headings, figure captions, notes in tables and figures, and 

footnotes).  See the appropriate department/program style manual (APA, 

MLA, etc.) for more information on single-spacing within a text. The text is 

divided into sections called headings (i.e. chapters, subdivisions). There must 

be an exact correspondence between the headings in the text and the 

entries in the Table of Contents. 
 

 Title Page – The title page contains the exact title of the thesis or research 

paper, the full name of the author, the degree to be awarded, the institution 

granting the degree, and the year the degree will be granted. The title page is 

to be followed by the Author’s Statement/Approval page. There is no 

difference between the title page of a thesis paper or research paper. If the title 

is more than one line, an inverted pyramid must be used. No title should be 

more than three lines.  

 

 Type Styles and Symbols – One size of type (12 pt. font preferably) must be 

used throughout the paper (with committee approval, a creative thesis may 

have exceptions). Hand-drawn symbols should be in India ink or other high-

contrast black ink. In fields such as Environmental Studies, special 

circumstances may require the use of a color on a map or diagram. Color may 

be used only when it is standard practice in the specific field. 
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Appendix A 
 

Traditional Sample Front Matter 
Pages 
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Label for Front Cover 
 
This is a sample of the label that goes on the front of the binder(s) for the thesis or 
research paper. 
 

Do not include this  
in your paper. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Label size is approximately 2”x 4”. Text must be centered vertically and 
horizontally. The label must be affixed to the front cover of the bound thesis 
copies (2) or research paper (1). 

 

 

 

THE TITLE IS IN ALL CAPS, CENTERED, AND 

SINGLE SPACED FOR THE THESIS OR 

RESEARCH PAPER 

(1 blank line) 

by 

(1 blank line) 

John H. Doe 



 (no page number) 
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Address Page 
 

Establish a left margin of 1.5 inches on ALL pages for binding purposes and be certain 
to maintain a margin of at least 1 inch on the top, right, and bottom of the page.   

From the 1-inch top margin, text begins on line 33, typed in upper and lower case, 
single-spaced, and centered. Do not place a page number on this page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

School of Graduate Studies 

Bemidji State University 

1500 Birchmont Dr NE, #48 

Bemidji, MN  56601-2699 

218-755-2027 

 



 i  
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Title Page 
 
Margins: 1.5 “ left; 1” top, right, and bottom. Center the text vertically on this page 
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Margins are 1.5” left, 1” top, right, and bottom. 
 
APA Style:  Please refer to the APA Manual, 6th Edition* (pp. 62-63), to determine how 
your headings should appear. Find the section of your paper that breaks into the finest 
level of subordinate categories. Then use the guidelines that follow to determine the 
level, position, and arrangement of headings.  
 

APA Manual 6th Edition  

 

One level.  Only use Level 1. Start each chapter on a new page. 
 
Example: 

(Arabic page number) 
 

 

Centered, Boldface, Uppercase and Lowercase Heading 

 

The indented, double-spaced text starts here. All headings (Level 1) are centered, 

boldface, and uppercase and lowercase. 

 

Two Levels.  Use Levels 1 and 2. Start each chapter on a new page. 
 
Example: 

(Arabic page number) 
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descriptive notes with the source listings 
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The following example is consistent with a paper in the MLA format. Please refer to the 
MLA Style Manual and Guide to Scholarly Publishing 3rd Edition. Headings must 
be presented in a format identical to the format used in text.  
 
Roman numeral page number must be ½ inch from top edge and flush with right 
margin. Margins are 1.5” left, 1” top, right, and bottom. Center all text vertically 
within the margins unless the TOC extends beyond one page.  
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TABLE OF CONTENTS 

(1 blank line) 

Chapter Page 

1. Introduction ........................................................................................................1 

(1 blank line) 

2. Literature ..........................................................................................................10 

 (1 blank line) 

3. Discussion ........................................................................................................22 

(1 blank line) 
4. Conclusion .......................................................................................................37 

(1 blank line) 

Works Cited .......................................................................................................................40 

(1 blank line) 

Works Consulted ................................................................................................................41 

(1 blank line) 

Appendix ............................................................................................................................43 
 
Two-page TOC – If the Table of Contents is too long for one page, insert a break 
between sections and continue on the next page. Begin the continuation at the 1-inch 
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Page Numbers – Align the page numbers flush right with dot leaders.  

 In Microsoft® Word 2007, from the Home tab, go to the Paragraph section and 
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Arabic page number must be ½ inch from top edge and flush with right margin.  
Margins are 1.5” left, 1” top, right, and bottom. 
 

MLA Style:  Please refer to the MLA Style Manual and Guide to Scholarly 

Publishing 3rd Edition. 
 

 Start each chapter on a new page. 
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Chapter I 
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Introduction 
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double spaced throughout the research or thesis paper. Chapters should begin on a new 
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As a corollary to Robert Angell’s measures of world order, this study examines nation- 

state differences in support for world order as a function of learning through involvement 

in the United Nations.  Differences in national support for world order are analyzed in 

terms of “role-taking” and “cue-taking” in the United Nations. Seven types of roles, 

based on the degree to which nation-states approximated support for the norms of the 

organization, are identified.  Correlational analysis indicates that these roles function as 

good predictors to variance among nations in their support for world order. Alternatively, 

nations which could not be classified as taking on a definitive role were hypothesized to 

be “taking cures” about the value of global cooperation from their regional counter parts.  

This predicted outcome was also supported.  Finally, analysis of “deviant” cases 

indicated that for some nations, both role-taking and cue-taking may be equally salient 

for supporting world order.  
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MLA Style Manual and Guide to Scholarly Publishing 3rd Edition. Headings must 
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